Software Guide
for Windows
• ZoomBrowser EX
• CameraWindow

• Movie Uploader for YouTube
• PhotoStitch
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Special Features

Transfer Images and Movies

Insert Text

Save Still Images
From Movies

ABC
Print Images

Edit Movies

A
Back Up to a CD

Attach Images to
Email

Plus many other useful features
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About this Manual
Notation Conventions
The contents of this manual are classified according to the following symbols.
IMPORTANT
• The “Important” sections contain operating precautions or important topics.
Ensure that you read them.
HINT
• The “Hint” sections contain procedural suggestions and tips for your convenience. Read them as
necessary.
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Operating Environment

• This manual uses Windows Vista screen shots and procedures in the explanations.
The screen shots and procedures may appear slightly different if you are using
another version of Windows.
• The displayed screens and procedures may also differ slightly from the examples
depending upon the camera or printer model in use.
• The explanations in this guide are based on the premise that a Canon compact
digital camera will be used with the software.
• Some functions may not be available depending on the camera model.

Word Searches
This document is provided as an Adobe Reader document. Use Adobe Reader’s Search
functions to find specific words or phrases that you recall but cannot find. To access
this function, in Adobe Reader click the [Edit] menu and select the [Search] option.
If you are using Adobe Reader 8 or later, you can also perform searches with the [Find]
function right on the toolbar.

Input search text here
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Precautions for Connecting the Camera to the Computer
• When connecting the camera to the computer with an interface cable, make sure to connect
the cable directly to the computer’s USB port. The connection may not operate correctly if
you attach the camera to the computer via a USB hub.
• The connection may not operate correctly if you are using other USB devices, excluding
USB mice or keyboards, at the same time as the camera. If this occurs, disconnect the other
devices from the computer and try reconnecting the camera.
• Do not connect two or more cameras at the same time to the same computer. The
connections may not operate correctly.
• Do not allow the computer to go into sleep (standby) mode while a camera is connected
via the USB interface cable. If this does happen, do not disconnect the interface cable. Try
to awaken the computer with the camera in the connected state. Some computers will not
awaken properly if you disconnect the camera while they are in sleep (standby) mode. Please
refer to your computer manual for instructions regarding the sleep (standby) mode.
• Do not disconnect the camera from the computer if CameraWindow is displayed on the
screen.
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IMPORTANT
• You are recommended to use an AC adapter (sold separately) when connecting
to a computer. Ensure that you use fully charged batteries if you cannot use an
AC adapter.
• See the Camera User Guide for procedures on connecting the camera to the
computer.
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CameraWindow and ZoomBrowser EX
CameraWindow and ZoomBrowser EX
The following two windows are the main ones used for CameraWindow and
ZoomBrowser EX procedures.

CameraWindow
This is software that communicates
with the camera.
You can use it to transfer images
to and from the camera, organize
images on the camera, and upload
movies on the camera to web
services.
The menu screen at the right
will appear when the camera is
connected to a computer.
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After the images are transferred from the camera,
the screen changes when CameraWindow is closed.

ZoomBrowser EX

This is software that manages
images transferred to a computer.
You can use it to view, edit and
print images on a computer. If
you close CameraWindow after
transferring images, the window at
the right will appear.
You can also open the
window by doubleclicking the icon on the
desktop.
HINT

Use the Help Function
The
(Help) button or Help menu is available in most CameraWindow and ZoomBrowser EX windows. It
is there for when you are unsure how to proceed.
Table of Contents
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ZoomBrowser EX’s Main Window
How to Display the Main Window
ZoomBrowser EX’s Main Window will appear after the camera images are
transferred and CameraWindow closes. You can also display it by doubleclicking the ZoomBrowser EX icon on the desktop.

Names of the Main Window Parts
Menu Bar

Task Buttons
Selects tasks to
perform.

Last Acquired Images
Displays the last images
transferred.

Folder Area
Selects a folder
to display.

Function Buttons

Display Control Panel
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Browser Area
Icons that indicate image properties display
around images, as shown on the left.

Properties Icon (Displays Image Properties)
: Image recorded using the camera’s Stitch Assist
mode

: Movies recorded with Movie Digest mode
: Image with sound memo attached

: RAW image

: Protected image

: Movie

: Image recorded using the camera’s AEB function

: Super Slow Motion Movie

: Rotated image (rotated in display only)
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How to Perform Tasks
Selecting Tasks and Task Window Procedures
Many ZoomBrowser EX functions can be accessed by selecting a task in the Main
Window and following the instructions in the guidance section of the new window.  
For further details on the functions, refer to “List of Available Functions” in the
appendix.

1

Select a task.
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The major steps for the
task appear here.
Follow the steps in order.
You can return to a
previous step.
An overview for the
selected task appears here.

Cancels the procedure and
returns to the previous
window.

2
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Follow the instructions
to perform the task.
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Transferring Images
Transferring Images by Connecting the Camera to a Computer
Transfer the camera images to the computer.

IMPORTANT
• The instructions in this software manual assume that you have correctly installed
the software. See the Camera User Guide for software installation procedures.
• For details on how to connect the camera to a computer, refer to the Camera User
Guide. Please also refer to “Precautions for Connecting the Camera to the Computer”.
• With some versions of Microsoft Windows, CameraWindow may not open when
the camera is connected. In this case, double-click the ZoomBrowser EX icon on the
desktop to start ZoomBrowser EX and open the Main Window. Click the [Acquire &
Camera Settings] task button, followed by [Connect to Camera].

1
2
3
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Connect the camera to the computer with the supplied interface cable.
Turn on the camera power, set it to playback mode and prepare it to
communicate with the computer.
When a window similar to the one at
the right appears, click [Downloads
Images From Canon Camera using Canon
CameraWindow].
With Windows XP, click [Canon CameraWindow]
then [OK] in the AutoPlay window.
For Windows 7, use the following steps to display
CameraWindow.
1. Click
on the task bar.
2. In the screen that appears, click the
link to modify the program.
3. Click [Downloads Images From Canon Camera using Canon CameraWindow], then
click [OK].
4. Double click .
Table of Contents

9

Things to
Remember

4

Mastering
the Basics

More Advanced
Techniques

Appendices

CameraWindow (Menu Screen)

Click [Import Images from
Camera], and then click
[Import Untransferred
Images].
Only images that have not yet
been transferred will start to
transfer.
After you click [OK] in the
dialog that indicates the transfer
is complete and close the
CameraWindow screen, the
transferred images will display in
the Main Window.
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You can select the newly transferred images
by their shooting dates or My Category
(select models only) classification.

: Folders containing newly acquired images

• Images from memory cards with large numbers of images (more than 1,000) may not transfer
correctly. If this happens, please use a memory card reader to transfer. For details on transferring
images from a memory card reader, refer to “Transferring Images Using a Memory Card Reader”.
• Movie files take time to transfer since the files are large.

HINT

Changing the Transfer Destination Folder
The default settings save transferred images into
the [Pictures] or [My Pictures] folders. To change the
destination folder, click the
button shown on the
right in Step 4 as described above, then click the [Import]
button. In the [Folder Settings] tab, click [Browse] to
complete settings in the screen currently displayed.
Changing the software that displays after images
have been transferred
You can choose the software that displays after images
in the upper right corner
have been transferred. Click
of CameraWindow, then click [Import] in the screen that
appears and choose the [After Import] tab. After making
your settings, press [OK] and close the [Preferences]
screen.

Table of Contents
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HINT
Select Images to Import
To transfer only a selection of images from the
camera, click [Import Images from Camera] in
CameraWindow (menu screen), [Select Images
to Import], then select images in the image
transfer screen, and click the
(Import)
button. For details, refer to “Image Transfer
Screen”.
Import All Images
To transfer all images on the camera,
click [Import Images from Camera] in
CameraWindow (menu screen) then, [Import
All Images].
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Automatically Transferring Images on
CameraWindow Start-Up
To automatically transfer images when
CameraWindow starts up, click the button
shown on the right in CameraWindow (menu
screen), then click the [Import] button, and
the [Auto Import] tab. Add a checkmark to [Start importing images automatically when this software is
launched.].
Transferring Images Using a Memory Card Reader
An action selection window will open when you insert a memory card into the memory card reader. If you
select [View/Download Images Using Canon ZoomBrowser EX], ZoomBrowser EX will start and display the
following window. Use this window to perform the transferring procedures.

Transfers all images that have not yet been
transferred.
Allows you to select and transfer images.
Prints images.

Configures the transfer folder and
other settings.

IMPORTANT
• Movies transferred with the Windows 7 transfer function may not be correctly
processed in ZoomBrowser EX. Transfer the movies with the included software.

Table of Contents
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Printing
Printing a Single Image on a Single Page
Prints one image per page.

Y
P
O
C

HINT

Printing Movies
Movies cannot be printed, but you can extract still images from movies, and print them after they have
been saved. For details on how to save still images from movies, refer to “Extracting Stills from Movies”.

1

Click the [Print & Share] task button in the Main
Window.

2

Click [Photo Print].

3

Confirm that [1. Select
Images] is chosen and select
images for printing.

Table of Contents
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Click [2. Printer and Layout Settings] and set the categories as desired.
Sets the printer, paper
size and borderless
printing settings.

Click here to crop and print a portion of an image.
Click here to insert text
onto an image and print.
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Sets the shooting date/time imprint settings.

5

Click [3. Print].
Printing will start.
HINT

Printing Using Other Software
If you have specialized printing software installed on the computer, you can also use it to print the
images. Click the [Print & Share] task button in the Main Window, followed by [Print Using Other
Software].

Table of Contents
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Index Print
Prints an index of the images.
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1

Click the [Print & Share] task button in the Main
Window.

2

Click [Index Print].

3

Confirm that [1. Select
Images] is chosen and select
images for printing.

Table of Contents
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Click [2. Printer and Layout Settings] and set the categories as desired.
Select an image to
rotate or trim.
Sets the printer and
paper size settings.

Sets the number of
rows or columns.
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Rotates selected
images.

Click here to crop a
portion of the selected
image and print it.
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Configures the printing of the shooting information,
comments, headers, footers or page numbers.

Click [3. Print].
Printing will start.
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How to Use CameraWindow
First Menu Screen to Open
This screen appears when the camera is connected to your computer.
Click each button to display the available options.
Displays in-camera
memory card
information.

Displays camera information.
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Starts operations for
transferring images from the
camera to your computer.
Starts operations for
protecting, rotating, and
deleting images on the
camera. Also transfers images
from your computer to the
camera.
Starts operations for
uploading movies on the
camera to web services.
Starts operations for setting
the camera start-up screen,
start-up sound, and various
camera sounds. For details,
refer to “My Camera
Settings” in “More Advanced
Techniques”. This menu may
not appear depending on your
camera model.

HINT
Customizing CameraWindow Functions
If you click the
button as shown in the upper right of the screen, you can customize various functions
to make CameraWindow easier to use. You can change the automatic transfer settings, the start-up
screen that appears when starting CameraWindow, and the transfer destination folder.
Table of Contents

16

Things to
Remember

Mastering
the Basics

More Advanced
Techniques

Appendices

Image Transfer Screen
This screen appears when you click [Import Images from Camera] on the Menu screen,
then click [Select Images to Import]. Select the image you want to transfer and click
the
button to transfer the image to your computer.
Viewer Window (Thumbnail Display)

Turns the shooting date and folder name below the
thumbnails on and off (when in thumbnail display).
Changes thumbnail size
(when in thumbnail display).

Returns to the Menu screen.

Closes CameraWindow.
Switches between window display
modes.
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  Thumbnail display
  Preview display
  Full screen display

Double-clicking an image switches
to preview display.

This mark appears on images that
have not yet been transferred.

Images on the camera
that match the selected
filter display in the area
to the right.
Rotates chosen images
90° to the left or right.

Transfers the image chosen
in Viewer Window to your
computer.
Cancels image selection.
Selects all images.

The background of chosen images turns blue.

IMPORTANT
• The functions (buttons) that display will differ depending on the camera model.
Table of Contents
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Organize Images Screen
This screen appears when you click [Organize Images on Camera] on the Menu screen,
then click [Organize Images]. Clicking a folder on the left will display all images within
the folder as thumbnails (small images) on the right of the screen.
Viewer Window (Thumbnail Display)

Turns the shooting date and folder name below the
thumbnails on and off (when in thumbnail display).
Changes thumbnail size
(when in thumbnail display).

Returns to the Menu screen.

Closes CameraWindow.
Switches between window display
modes.

Y
P
O
C

  Thumbnail display
  Preview display
  Full screen display

Double-clicking an image switches
to preview display.
This mark appears on images that
have not yet been transferred.

Images on the camera
that match the selected
filter display in the area
to the right.
Rotates chosen images
90° to the left or right.

Deletes the image chosen
in Viewer Window.
Protects/cancels protection
for the image chosen in
Viewer Window.
Transfers images on your
computer to the camera.

The background of chosen images turns blue.

IMPORTANT
• The functions (buttons) that display will differ depending on the camera model.
• Clicking the
(Delete) button will delete the image from the camera. Exercise
adequate caution, as you cannot retrieve the deleted images.
Table of Contents
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How to Use ZoomBrowser EX’s Main Window
Main Window
This is the main window for performing tasks in ZoomBrowser EX.
Slide Show
Displays the selected images in
succession in the window.
Properties
Displays information about a
selected image.
View Image
Displays the selected image
in the Viewer Window.
Task Buttons
Selects a task to perform.
Last Acquired Images
You can check images
by shooting date or My
Category.

Search
Performs searches on images.
Delete
Deletes the selected images or folders.
• Deleted images are sent to the Recycle Bin on
the desktop.
• The association between a sound memo and
an image cannot be recovered from a file
restored from the Recycle Bin.
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Rotate
Rotates a selected image.
• Click the [Edit] menu and select [Rotate
According to Rotation Information] to
rotate the original image as well in the
displayed direction.

Display Mode
Selects a display mode
for the Browser Area.
Display Control Panel
Configures the settings
for displaying images in
the Browser Area.
Browser Area
Displays the images in
an index list.

Folder Area
Selects a folder to display.
• You can register folders you use often as Favorite Folders (
). Register by clicking [Add].
To delete a folder in the Favorite Folders area, select a folder and click the [Remove] button.

Table of Contents
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Display Modes
Select a browser area display mode to fit your purposes.

Zoom Mode: suited for
surveying many images.

HINT

Scroll Mode: allows
thumbnails to be viewed at a
size suited for easy viewing.

Preview Mode: allows the
image information to be read
while viewing the image.

Y
P
O
C

Magnify Thumbnails to Check Images
In zoom mode or scroll mode, positioning the mouse pointer over a thumbnail causes the image to
appear at a higher magnification in a Mouse Over window. You can also set the Mouse Over window to
not show in the
(Show Information) menu.

Display Control Panel

This panel adjusts the display settings for the Browser Area.

Fit to Window
Changes the thumbnail size
to fit them into the window.

Selection Menu
Click this to select/deselect all
images in the Browser Area.

Select Button
Use this to select images
in Zoom mode.

Show/Hide Image Information Menu
Select here to show/hide such image
information as the file name or shooting
date or rating beneath the
thumbnail.
Zoom Button
Use this to zoom in
and out on an image.

Table of Contents

Display Size
Changes the size of the
thumbnail in the Browser Area.

Scroll Button
Use this when in
zoom mode to move
the displayed portion
of the image (drag
inside the browser
area).

Filter Tool Menu
Displays only images
that correspond to
specific conditions.
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Browser Area Tasks
Change the Folder Level
The level of folder displayed can be changed with the
following procedures.
• In Zoom mode, position the mouse cursor over the
folder and click the
icon when it displays.
• In Scroll or Preview mode, double-click the
icon.
icon.
• To advance to a higher folder level, click the

Change the Display Size
You can change the
display ratio (Zoom mode)
or thumbnail size (Scroll
mode) with the slider.

Select Images
Clicking an image in the Browser Area selects that
image. To select multiple images, hold down the [Ctrl]
key while clicking images, or hold down the [Shift] key
and click a starting and ending image to select a range
of adjacent images.
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Display Images
Double-clicking an image in the Browser Area (or
(View Image)),
selecting the image and clicking
displays it in the Viewer Window.

Create New Folder
To create a new folder in the Browser Area,
click the [File] menu and select [New Folder].

HINT

Move, Copy Images
To move an image between folders, drag it over the
destination folder and release the mouse button.
To copy an image, hold the [Ctrl] key while releasing
the mouse button as above.
You can also use the same procedures to copy images
between Windows Explorer and the Main Window.

Right-Click Context Menus
Right-clicking over a window or image displays contextual menus. These menus contain the functions
available in the current context as well as other convenient functions. Use the right-click menus to
increase your efficiency.  
Using the Navigator
If you change the displayed zoom factor in Zoom Mode, a Navigator Window that shows the current
position will appear. In the Navigator Window you can change the position by dragging
or clicking
inside the window.

Table of Contents
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Properties Window
The Properties Window displays when you select an image in the Browser Area and
click the Properties button. The Properties Window does not display in the Preview
Mode.

Shows or hides categories.

File Name
The file name can
be changed.
Rating and My
Category
Sets the rating for an
image.
An icon will display if a
My Category is set (certain
models only).

Protect
Prevents an image from
being overwritten or deleted.
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Comment
You can type a comment here.
Keywords
Sets the keywords used in
searches.
Brightness Histogram
A graph of the highlights and
shadows distribution in an
image.

Shooting Information
Displays detailed information,
such as the shutter speed and
exposure compensation setting.
The camera model will determine
what information is displayed.

Image Selector Buttons
When multiple images are selected, you
can switch between images that display
information in the Properties Window.

Table of Contents

22

Things to
Remember

Mastering
the Basics

More Advanced
Techniques

Appendices

Viewer Window
Double-clicking an image in the Main Window displays it in this window.
Change the display magnification.
Zooming in displays the Navigator window
to show the relative position on the image.

Edit an image.
Display the shooting information.
You can configure the information display by clicking
the [Tools] menu and selecting [Preferences].

Display multiple
images side by side.

Display at full
screen size.
Set ratings.
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Shooting
information

• The following window will appear when a movie is displayed.

You can extract
stills from movies.

You can cut
portions at either
end of a movie clip.

You can control movie
playback and sound
volume.

• A bar for changing the playback speed, and
(real-time playback) will appear when a Super Slow Motion
, the movie will play back at the actual speed it was shot at.
Movie is displayed. If you click

Table of Contents
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Editing Images
IMPORTANT
• The original image will be overwritten after an image is edited unless the file
name is changed before saving it. To preserve the original image intact, change
the file name when saving the edited image.
• This section introduces the procedures started by clicking the Edit task button. Images can also be edited in
a similar way by clicking the [Edit] button in the Viewer Window.

Red Eye Correction
Restores eye appearance to the original color when light reflected from the flash
makes them appear red.
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Procedures

1

• Click [Start] when Auto mode is selected.
• Switch to Manual mode if Auto mode cannot correct the
image, and select the location of the eye to correct.  

Auto Adjustment

2
3
4
5

Select a task from the left
side of the window:
[Edit] and [Edit Image].
Select an image.
[2. Select Editing Tool]
[Red Eye Correction]
[3. Finish]

• Movies and RAW images cannot be
edited.

Automatically adjusts the image color balance and brightness.
Procedures

1
2
3
4
5

Select a task from the left
side of the window:
[Edit] and [Edit Image].
Select an image.
[2. Select Editing Tool]
[Auto Adjustment]
[3. Finish]

• Movies and RAW images cannot be
edited.
Table of Contents
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Color/Brightness Adjustment
You can adjust image color balance and brightness using a variety of methods.
Brightness,
Saturation,
Contrast

Procedures

1

RGB Adjustment

2
3
4

Level Adjustment

Select a task from the left
side of the window:
[Edit] and [Edit Image].
Select an image.
[2. Select Editing Tool]
[Color/Brightness
Adjustment]
[3. Finish]
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5

Tone Curve Adjustment

• Movies and RAW images cannot be
edited.

Adjusting Sharpness – Emphasizing Outlines

Makes images appear sharper by emphasizing the outlines of subjects, such as people
and objects.
Procedures

Sharpen

Unsharp Mask

1
2
3
4
5

Select a task from the left
side of the window:
[Edit] and [Edit Image].
Select an image.
[2. Select Editing Tool]
[Sharpness]
[3. Finish]

• The Unsharp Mask [Radius] is the size
at which the outline is detected and the
[Threshold] is the standard value at which
the outline is determined.
• Movies and RAW images cannot be
edited.
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Trimming – Cropping a Portion of an Image
Use this to delete unnecessary portions of the image and leave only the necessary
portions.
Procedures

1
2
3
4
5

Select a task from the left
side of the window:
[Edit] and [Edit Image].
Select an image.
[2. Select Editing Tool]
[Trim]
[3. Finish]
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• You can also input values or an aspect
ratio to specify the trim area.
• Movies and RAW images cannot be
edited.

Inserting Text

Use this to insert text onto the image.

Procedures

You can freely adjust the font,
size, color and text attributes.

HELLO

1
2
3
4
5

Select a task from the left
side of the window:
[Edit] and [Edit Image].
Select an image.
[2. Select Editing Tool]
[Insert Text]
[3. Finish]

• Placing a checkmark in the [Antialias] box
causes the text edges to blend in with
the underlying image.
• Movies and RAW images cannot be
edited.
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Using Other Editing Software
If you register another image editing program with ZoomBrowser EX in advance, you
can use that software to edit an image selected in ZoomBrowser EX.

Registering an Editing Program
Procedures

Register the program so
it can be started from
within ZoomBrowser EX.

ZoomBrowser EX

1
Other Image
Editing Program

2
3
4

Select a task from the left
side of the window:
[Edit] and [Edit Image].
Select an image.
[2. Select Editing Tool]
[Edit with external image
editor]
[Manage List]

Y
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5

Editing Images with a Registered Editing Program

Procedures

1
2
3
4
5

Select a task from the left
side of the window:
[Edit] and [Edit Image].
Select an image.
[2. Select Editing Tool]
[Edit with external image
editor]
[3. Finish]

• The shooting information may be lost
from images recorded with the camera
and then processed and saved with
another image editing program.  
• Movies and RAW images cannot be
edited.
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Attaching Sounds
You can add sound effects or background music to images and play back the sounds.

Adding Sound
Procedures

+

1
2
Symbol displayed on image
thumbnails to which sound
files have been added.

Select an image.

[Edit] and [Add/Remove
Sound].

Y
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• WAVE type sound files (extension
“.wav”) can be attached to images.
• Attaching a sound file to an image results
in the selected sound file being copied
into the same folder as the image file.

Playing an Image Sound File

Procedures

1
2

Select an image.

[Edit] and [Play Sound].

Table of Contents
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Creating Panoramic Images – PhotoStitch
You can create wide panoramic images by moving the camera slightly when recording
a series of images and merging them into one image.
Procedures

1

Select a task from the left
side of the window:
[Edit] and [Stitch Photos].

• Movies and RAW images cannot be
edited.

Y
P
O
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Use the PhotoStitch program
to create panoramic images.

HINT

Using the Stitch Assist Mode
If you use the camera’s Stitch Assist mode to record the images, PhotoStitch can automatically detect the
image order and merge direction, making it easier to merge the images. (Some camera models may not
feature the Stitch Assist mode.)

IMPORTANT
• If a message appears, notifying you that the computer has insufficient memory,
try one of the following methods to solve the problem.
• Close all other applications other than PhotoStitch.
• Reduce the size or number of images to combine.
• In the [Save] tab, select [Adjust image...], then in “Saved Image Size“ reduce
the size.
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Editing Movies
You can create original movies by linking movie clips and still images.
You can even add titles and other text, background music and various special effects
to the movie.

ABC

Procedures

1

Select a task from the left
side of the window:
[Edit] and [Edit Movie].
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HINT

Recordable Movie Length
• The length of movies you can save is shown at right. A
message will appear if you try to save a longer movie.
Reduce the length or size of the movie if this happens.

Changing the Playback Speed of a Super Slow Motion
Movie and Saving it as a New File
• Click [Slow Play Speed] in step 2 to change the playback
speed (only with Super Slow Motion Movies).

Movie Size
1920x1080
1280x720
640x480
320x240

Max. Length
Under 10 minutes
Under 20 minutes
Under 30 minutes
Under 60 minutes

IMPORTANT
• Movies edited with this function cannot be transferred back to the camera.
• Saving movies takes time, especially MOV type movies selected with [Save
image type] takes a considerable amount of time.
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Converting RAW Images – Digital Photo Professional
You can convert RAW images to JPEG and TIFF images.
Digital Photo Professional’s Main Window

Procedures

1

2

Y
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3
4

Selects folders containing images.

Select a task from the left
side of the window:
[Edit] and [Digital Photo
Professional Process RAW
Images].
Select a RAW image in
Digital Photo Professional’s
Main Window.

• The modified contents (the
information for image processing
requirements) are saved along
with the image as a “recipe”.
• With Digital Photo Professional,
you can adjust images to achieve
the best results for your desired
scene or subject by specifying a
picture style.
• The items available to be modified
differ depending on the camera
model.

Digital Photo Professional’s Tool Palette

You can adjust all three RGB channel
levels together or separately with the
Tone Curve.
Reduces noise that occurs when
shooting night time scenery, or
when shooting at a high ISO speed.

Adjusts the brightness, white
balance and picture style.

Click
(Edit image window).
Adjust the image brightness
and white balance in the
tool palette.

5

[File] and [Convert and
save].
• After setting the file type, size,
and destination folder, click [Save].

Adjusts attributes such as the
contrast, color tone and color
saturation.

Table of Contents

• Only RAW images compatible with Digital
Photo Professional can be processed.
• Ensure that you use the RAW image
conversion software included with your
camera.
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To print, using Digital Photo Professional, select an image in the Main Window, then
click the [File] menu and select the print function. Digital Photo Professional offers the
following printing methods.
Printing Method

Description

Single Print

Automatically sets the layout for printing a single image on a single page.

Detailed Setting

Gives you the freedom to set the layout, add titles, or print with shooting information.

Contact Sheet

Prints a line-up of multiple images on one page (also allows you to select the number of
images, layout, and add titles).

IMPORTANT
• RAW images can only be captured on certain camera models that list “RAW” as one of
the data types included in the “Specifications” section of the Camera User Guide.
• Only RAW images compatible with Digital Photo Professional can be processed. Check
the “Data Type” item of the “Specifications” section of the Camera User Guide for
compatibility.
• For a more detailed explanation of operating procedures, download the Digital
Photo Professional manual (PDF format) from the Canon website.
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HINT

About RAW Images
RAW images contain the data captured by the camera’s image sensor without modification. Since
they contain raw data that differs from the usual JPEG images by not having any image adjustment or
compression processing performed in the camera, they can be converted on a computer with a lossless
process.
Processing in the Camera

Standard Image
Capture
Image sensor
data from
shutter release

Processing by Computer

Image Adjustment
Compression

JPEG Image

Image adjustment
& compression
automatically performed

RAW Image
Capture

• Can be used with general programs.
• Image is subject to degradation when
adjusted because it has been compressed.
Digital Photo Professional
RAW Image Processing

RAW Image

Image Adjustment
Compression

JPEG Image,
TIFF Image

• You can view the image while making
adjustments without worrying about quality
loss.
• Processing with Digital Photo Professional
is required to view the images with general
programs.
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Exporting
Changing Image (Stills) Sizes and Types
You can change an image’s size and format when exporting it so that it can be
published on the Internet or attached to an email message.
Procedures

1

Select a task from the left
side of the window:
[Export] and [Export Still
Images].
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• You will lose the shooting information
if you save images as a type other than
JPEG.

.bmp

.jpg

.tif

Changing Movie Sizes and Types

You can change a movie’s size and format when exporting it so that it can be
published on the Internet or attached to an email message.
Procedures

1

Select a task from the left
side of the window:
[Export] and [Export
Movies].

• You can also use this function to rotate
movies.

.avi

.mov

Table of Contents

IMPORTANT
• Exporting movies may take a
considerable amount of time.
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Extracting Stills from Movies
You can extract and save stills from your favorite frames recorded in a movie.
Procedures

1

Select a task from the left
side of the window:
[Export] and [Extract frames
from a movie].

Y
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Extract your best
shots as stills

Exporting Shooting Information

You can export the shooting information recorded with an image, such as the shutter
speed and exposure, as a text file.  
Procedures

1

Select a task from the left
side of the window:
[Export] and [Export
Shooting Properties].

Ascertain the causes of
failed photos or compare the
settings for several images.
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Creating Computer Screen Saver Images
You can export images to serve as computer screen savers.
Procedures

1

Select a task from the left
side of the window:
[Export] and [Export as a
Screen Saver].

Y
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Creating Computer Wallpaper Images

You can export images to serve as computer wallpaper images.

Procedures

1

Table of Contents

Select a task from the left
side of the window:
[Export] and [Export as a
Wallpaper].
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Saving to CDs
You can save images along with their shooting information to CD-R/RW discs.
Procedures

1

Select a task from the left
side of the window:
[Export] and [Backup to CD].

Back up important images
or distribute your vacation
photos on discs.
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IMPORTANT
• This function can only be used with computers that satisfy the following
requirements:
• Equipped with a CD-R/RW drive as standard equipment
• Writing to the CD-R/RW drive operates correctly with Windows
• If a window similar to that shown to the right appears when
a new CD-R/RW disc is placed in the drive, click
([Cancel]
when using Windows XP) to close the window.
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Uploading Movies to YouTube
Uploading to YouTube – Movie Uploader for YouTube
You can upload movies you have shot to YouTube. You can upload movies saved on
the camera or a computer.
Procedures

1

Connect the camera
to a computer to start
CameraWindow.
• For details, refer to steps 1- 3 in
“Transferring Images”.
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2
3
4
5
6
7

HINT

[Upload Images from
Camera]
[Upload Movies to YouTube]
Select movies.
Click
(Next).
Input a title and description,
then click
(Upload).
Enter your YouTube
username and password,
and sign in.

Uploading Movies Saved on a Computer
Click the [Print & Share] task button on the left side of the Main Window, then click [Upload movies to
YouTube]. The selected movie will be added to the list that appears on the screen. Set a title and explanation
for the movie, then click the
(Upload) button.

•
•
•
•
•

IMPORTANT
Depending on YouTube specifications, or future changes to specifications, this
function cannot be guaranteed.
The maximum length for uploadable movies is less than 10 minutes, and the
maximum file size is less than 1 GB.
Movies that have been edited on a computer cannot be uploaded.
Internet access is required to upload movies (You must already have an account
with an Internet service provider (ISP), browser software installed and an
Internet connection).
Any ISP account charges and access fees must be paid separately.
Table of Contents
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Email
Attaching Images to Email
You can send images as email file attachments.
Click here for most images.

Click here when you want to
change the image size or image
quality settings, then click [Custom
Settings] to change settings.

Procedures

1

2

Select a task from the left
side of the window:
[Print & Share] and [Email
Images].
Select an image to send.
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• You can also select multiple
images or all images in a folder.

3

Click [2. Change Image Size]
• You can change the image size
and quality settings.

4

Click here to check the
options currently set.
Click here to check what the
actual compressed file size will be.

Click here to preview the
compressed image.

Click [3. Finish]
• The mail software will start, and the
send screen will appear. The selected
image will appear as an attached file.
• In [Custom Settings], if [Save
to Folder] is selected in “After
Finishing the Task”, the selected
images will be saved in the
indicated destination folder.

HINT
Automatic Start-up Settings for E-mail Software
• When using Windows 7, you must pre-install an e-mail program. When changing settings, set the
default program by clicking the [Start] menu, followed by [Default Programs].
• When using Windows Vista, configure the settings in your e-mail software. For example, you can
configure Windows e-mail by starting e-mail, then clicking the [Tools] menu, followed by [Options],
[Default Messaging Programs], [This application is not the default Mail handler], and [Make Default].
• When using Windows XP, settings can be configured by starting the Internet Explorer program, and clicking
the [Tools] menu, followed by [Internet Options], [Programs] tab, and the [E-mail] pull-down menu.

IMPORTANT
• The e-mail’s MAPI client must be preset for the e-mail software to start automatically.
• If the e-mail software does not start automatically, first save the images to your
computer, then start your e-mail software to attach and send the images. The
destination folder for saved images can be set with [Custom Settings].
Table of Contents
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Slide Shows
Viewing Images in Slide Shows
A multiple selection of images can be shown at full size on the screen in succession as
a slide show.
You can freely configure the
transition effects, information
displayed and display time settings.

Procedures

1

Select a task from the left
side of the window:
[View & Classify] and [View
as a Slide Show].
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HINT

Slide Show Button Functions
The following buttons appear at the bottom of the screen while a slide show is playing.
You can set the Rating for an
image while it is displayed.

After the slide show,
the images you
clicked during the
show remain selected.

Table of Contents

Rewind

Pause

After the slide show,
the images you clicked
during the show appear
in a printing window.

Forward

Stops the slide show.
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Image Management
Changing File Names in Batches
You can change the file names of multiple images in one procedure.
Procedures

1
Name + Number
Shooting Date + Number

Shooting Date + Name + Number

xxx_02

xxx_03

• You can change individual file and folder
names by clicking the [File] menu and
selecting [Rename] or by clicking on the
file name in Preview mode.
• Changing the image name in
ZoomBrowser EX also changes the actual
file name on the disk.
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Name + Shooting Date + Number

xxx_01

Select a task from the left
side of the window:
[View & Classify] and
[Rename Multiple Files].

Change randomly
numbered images
and received images
into consecutively
numbered images.

xxx_04

xxx_05

Sorting Images into Folders by Shooting Date
You can sort images into folders by their shooting dates.

Procedures
200x/05/15

200x/05/16

1

Select a task from the left
side of the window:
[View & Classify] and
[Classify into Folder].

200x/05/17

Images predating your use
of ZoomBrowser EX can
also be managed together.

Table of Contents
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Configuring Image Information Settings
Setting Ratings
There are seven rating levels for images: ,
,
,
,
, Unrated and Reject.
By using ratings, you can group your images for viewing or searching.
Procedures

1
2

Switch to [Preview Mode].
Set [Rating].

Y
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• Ratings can also be set with the
following:
- ZoomBrowser EX’s [Edit] menu or
Properties Window, or the rating
setting function of the Viewer Window.
- The camera’s [Tag as Favorite] function.
- Windows 7/Windows Vista’s [Rating]
function (excluding movies).
• If you overwrite your previous installation
when installing the software, existing
rating settings may change. Refer to the
Help function for details.

IMPORTANT
• The only cameras that can be used to rate images will list “Favorites” in the
“Playback Menu” table of the “Menus” section at the end of the Camera User Guide.

Inserting Comments
You can freely insert your choice of text as Comments.
Procedures

1
ite
Endless wh
hes
sandy beac

Trip to t
he
blue sea

Table of Contents

Relaxing
afternoon
snooze

2

Switch to [Preview Mode].
Insert [Comment].

• Comments can also be managed in the
Properties Window.
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Assigning Keywords
You can set Keywords for use in image searches.  
Procedures

1
Family,

s

Animals

Family, Trip

Select keywords

Friends, H

olidays

2

Switch to [Preview Mode].
Insert [Keywords].

• Keywords can also be managed from the
[Tools] menu or Properties Window.
• To add keywords, click the [Tools] menu
and select [Manage Keywords].
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HINT

About Image Information
This chart shows the information other than shooting information that can be added to images.
Information Type My Category

Categories
such as People,
Scenery, etc.

Content

Ratings

Comments

Keywords

Favorite images are rated by
adding stars ( ).

Text input
without
restriction
regarding
the shooting
circumstances
or associated
memories.

Selections are
made from a
list (editable)
of keywords,
such as the
photographic
subject, place or
action.

Camera

ZoomBrowser EX,
Digital Photo Professional,
Camera (Favorite),
Windows 7/Windows Vista (Rating)

Used in Searches

—

O

O

O

Used as Filter
Criteria

O

O

—

—

Display beneath
Thumbnail

O

O

O

—

Configuration
Method

Categories displayed beneath thumbnails can be selected by clicking

Table of Contents
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in the Display Control Panel.
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Searching, Filtering and Sorting Images
Searching Images
You can search images using parameters extracted from the information associated
with them.  
Procedures

1

Ratings
Keywords
Comments

Select a task from the left
side of the window:
[View & Classify] and
[Search].
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• After a search, the correlated images
display in the [Search Results] folder.

Revision Dates

Shooting Dates

HINT
Tasks Related to Search Results
You can select images in the [Search Results] folder and perform operations on them, such as printing or
copying them to other folders.

IMPORTANT
• Please note that deleting an image from the [Search Results] folder deletes the
original image. Use caution in deleting items from this folder.
Table of Contents

43

Things to
Remember

Mastering
the Basics

More Advanced
Techniques

Appendices

Filtering Images
You can use filters to display only images meeting the selected parameters in the
Browser Area.
Procedures

1
[Filter]
Ratings

My Category

Y
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This section is used to specify the filter criteria.

Sorting Images

You can sort images in the Browser Area based on the specified parameters.

D

C

A

E

B

Procedures

1

Name
Type

Shooting Date

Modification
Date

A

B

Ascending/
Descending
Order

C

Table of Contents
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Comparing Images
Comparing Multiple Images
When a good photo opportunity arises, you can shoot the same subject using different
shutter speeds and exposures. In ZoomBrowser EX, it is easy to compare images so that
minute differences can be detected.
Procedures

1
2
3

Select several images to
compare.
Click
[View Image].
Select
,
,
or
the Viewer Window.
Click
[Synchronize].

Y
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4

in

• Selecting [Synchronize] causes actions
such as increasing/reducing the
magnification level or scrolling around
the image to apply to all of the selected
images in lock step, making it easy to
check minute details of focus, coloring
and other image characteristics.  

Actions performed on an image, such as scrolling or changing the
magnification, are performed on the other image as well.

Table of Contents
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My Camera Settings
Changing the Shutter Sound and Start-Up Image
You can select from dedicated screens to register to the start-up screen that appears
when turning the camera on, and dedicated sounds to register to various camera
operation sounds (My Camera Settings).
My Camera Settings
• Start-up Image
• Start-up Sound
• Shutter Sound
• Operation Sound
• Selftimer Sound

Procedures

1

Connect the camera
to a computer to start
CameraWindow.

Y
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• For details, refer to steps 1- 3 in
“Transferring Images”.

2

[Camera Settings]

Select the desired item from
the following and make
settings.
u [Set Start-up Image]
u [Set Sounds]
u [Set Theme]

IMPORTANT
• My Camera Settings are only available on certain models, when [Camera
Settings] displays in CameraWindow.

Table of Contents
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registered in the camera.

You can register the
start‑up image, start‑up
sound, shutter sound,
operation sound
and self‑timer sound
collectively if you select
[Theme].

Appendices

My Camera Settings
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Select a My Camera Settings file to replace in the right-hand list
and click this button to register it in the camera. If multiple My
Camera Settings files are displayed in the left-hand list, choose
the file you want to replace first, then register it in the camera.

HINT

Downloading My Camera Settings Files
You can also download various files to use in My Camera Settings from CANON iMAGE GATEWAY.

Table of Contents
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Transferring Images
Transferring Images to a Camera
Images transferred once to a computer can be transferred back to the camera.
Procedures

1

Connect the camera
to a computer to start
CameraWindow.
• For details, refer to steps 1- 3 in
“Transferring Images”.

Y
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2

Show favorite images
to friends or connect
a TV to show them
on a large screen.

3
4
5

[Organize Images on
Camera]
[Organize Images]
(Upload)
Select images.

• If the Main Window is open when the
camera is connected (directly after
transferring for instance), open the
CameraWindow (menu screen) by
clicking the [Acquire & Camera Settings]
task button, followed by [Connect to
Camera].

IMPORTANT
• Cameras that use the “MOV” data type can play back movies transferred back to
the camera if movies were taken with that camera. Refer to the “Data Type” item
in “Specifications” near the end of the Camera User Guide to see if the camera
uses the “MOV” data type. You may not be able to play back movies taken with
another camera.
• Only still images compliant with Design rule for Camera File system standards
can be transferred to your camera’s memory card.
• You may not be able to transfer images back to the camera if they have been
edited on a computer, or if the image information has been modified.

Table of Contents
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CANON iMAGE GATEWAY
About CANON iMAGE GATEWAY (for U.S.A. customers only)
CANON iMAGE GATEWAY is an online photo service for the purchasers of this product.
Registering online allows you to use the various services.
IMPORTANT
• Internet access is required to use CANON iMAGE GATEWAY (You must already
have an account with an Internet service provider (ISP), browser software
installed and an Internet connection).
• See the homepage for information regarding browser versions (Microsoft
Internet Explorer, etc.) and settings to best connect to CANON iMAGE GATEWAY
online photo services.
• Any ISP account charges and access fees must be paid separately.

Registering
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First, register as a CANON iMAGE GATEWAY member.
Register

Procedures

1

Select [CANON iMAGE
GATEWAY] from tasks on
the left of the window,
then select [Register/Add
Product].

• You can register online using the
supplied CD-ROM. To do this, in the
installer panel, click [Register] underneath
CANON iMAGE GATEWAY.

Table of Contents
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Available Services
CANON iMAGE GATEWAY offers a variety of convenient and useful services.
Procedures
Upload and
share images

1

Create your own photo album
on CANON iMAGE GATEWAY
E-mail notifications
of album uploads

Friends and family can
freely browse images

Select [CANON iMAGE
GATEWAY] from tasks on
the left of the window.
Select the desired item from
the following and make
settings.
u [Register/Add Product]
u [Top Page]
u [View Online Photo
Album]
u [Upload Images]
u [Download My Camera
Contents]
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Access even from
mobile phones

Order prints
Order an original
collection of photos

My Camera Settings Files on
CANON iMAGE GATEWAY

Download files for My Camera
Settings (certain models only)

Table of Contents

Also, you get the
latest customer
support information,
just for registering
your product
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Preference Settings
Customizing ZoomBrowser EX
You can configure ZoomBrowser EX and CameraWindow to your preferences.
• Overall themes, such as
window appearances
• Processing methods for
images shot with the
camera on end
• Categories of shooting
information displayed
• Show/hide messages
• Print settings
• Zoom speed

Procedures
ZoomBrowser EX

1
[Tools] and [Preferences].
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CameraWindow

1

Click

(Preferences).

Customizing the Task Buttons

You can hide items that you do not usually use to streamline the task buttons.
Procedures

1

[Tools] and [Customize].

Table of Contents
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List of Available Functions
CameraWindow Functions
Function Names
Import Images
from Camera

Import Untransferred Images
Select Images to Import
Import All Images

Organize Images
Organize Images
on Camera
Upload Images
Upload Movies to YouTube
from Camera
Set Start-up Image
Camera Settings

Set Sounds
Set Theme

Uploads movies on the camera to YouTube.

Y
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General (General/Connected
Camera)
Import (Auto Import/Folder
Settings/After Import)

Preferences

Description of Function
Only transfers images from the camera that have not yet been
transferred.
Only transfers chosen images from the camera.
Transfers all images from the camera.
Protect, rotate, and delete images on the camera. Also transfers
images back to the camera from your computer.

Sets the camera start-up screen.
Sets camera sound effects (start-up sound, shutter sound,
operation sounds, self-timer sound).
Sets the camera start-up screen and sound effects in My Camera
Settings.
Sets the camera owner name, and start-up screen when
CameraWindow starts.
Sets the automatic transfer settings and destination folder.

ZoomBrowser EX Functions
Task Button Names

Connect to Camera
Acquire &
Camera Settings

Acquire Images from Memory
Card

Description of Function
Connects to the camera to open CameraWindow (menu screen),
and use CameraWindow functions.
Transfers images from a memory card. You can also select
images on the memory card and print them.

Transfer Images to Memory Card Transfers images from the computer to a memory card.

View & Classify

View as a Slide Show
Rename Multiple Files
Classify into Folder
Search

Table of Contents

Starts a slide show of the images selected in the Browser Area.
Changes the file names of the selected images in a single pass.
Classifies images and saves them into a specified folder.
Performs image searches using criteria such as the Rating,
modification date, shooting date, comments or keywords.
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Task Button Names
Edit Image
Stitch Photos
Edit
Edit Movie
Digital Photo Professional
Process RAW Images
Export Still Images
Export Movies

Export Shooting Properties

Export as a Screen Saver
Export as a Wallpaper
Backup to CD
Photo Print
Index Print
Print Using Other Software
Print & Share
Email Images

Upload movies to YouTube
Register/Add Product
Top Page
CANON iMAGE
GATEWAY

View Online Photo Album
Upload Images
Download My Camera Contents

Table of Contents
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Description of Function
Allows you to perform image editing, such as cropping, image
correction, inserting comments, and red-eye correction. You can
also use it to start other image editing programs.
Merges multiple images and creates a single large panoramic
image.
Edits movies or still images strung together. You can add text as
titles, or background music, and apply various effects.
Converts RAW images into JPEG or TIFF images. You can adjust
the image brightness, contrast and color balance among other
attributes during conversion.
Allows you to change the image size or type, and export it as a
new image.
Allows you to change the movie size or type, and export it as a
new movie.
Extracts still images from movies over a specified interval and
saves them as image files.
Allows you to select the necessary data from the shooting
information and export it as a text file.
Exports the image as a screen saver file.
Exports the image as a wallpaper file.
Copies images to a CD-R/RW disk for backup.
Prints one image per page. You can print “photos” easily.
Lines up small versions of the images in rows and prints.
Select the software to use and then print.
Converts the selected images to the appropriate size for
transmission by e-mail. You can also use it to automatically start
an e-mail program after conversion.
Uploads movies saved on the computer to YouTube.
Connects to CANON iMAGE GATEWAY and opens the
registration page.
Connects to CANON iMAGE GATEWAY and goes to the top of
the page.
Connects to CANON iMAGE GATEWAY and displays albums
created.
Connects to CANON iMAGE GATEWAY and uploads images.
Connects to CANON iMAGE GATEWAY and downloads images
and sounds for use with My Camera Settings.
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Extract frames from a movie

Export

More Advanced
Techniques
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Supported Image Types
The following is a list of image types supported by ZoomBrowser EX.

JPEG (.JPG)

Most cameras use this image type. It compresses at very high ratios, taking advantage
of the characteristics of the human eye. However, because it is an irreversible
compression method (part of the data is lost during compression), if you process and
save an image repeatedly using this method, the image may become rougher.

RAW (.CRW/.CR2)

This is a proprietary image type provided by Canon. It saves the output of the image
pixels from a digital camera without any deterioration in the quality of the image.
Some cameras might not support this image type.
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Windows bitmap (.BMP)

This image type comes standard with Windows. Most Windows programs support it.

TIFF (.TIF)

This is a relatively popular image type. It is widely supported by non-Windows
programs (such as Macintosh).

PhotoCD (.PCD)

This is the image type used for Photo CDs.

AVI (.AVI)

Standard Windows movie type. The movie icon appears in ZoomBrowser EX’s Browser
Area.

MOV (.MOV)

Movie type. The movie icon appears in ZoomBrowser EX’s Browser Area.
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Uninstalling the Software
The procedures for uninstalling the software are only required when you wish to
delete the programs from your computer or when reinstallation is required to fix
corrupted files.
IMPORTANT
• Computer administrator status is required to perform the following operation.
This explanation uses ZoomBrowser EX to demonstrate how to uninstall a program.
You can remove other programs with the same procedures.

1
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Click the Windows [Start] menu
and select [All Programs] or
[Programs], followed by [Canon
Utilities], [ZoomBrowser EX] and
[ZoomBrowser EX Uninstall].

The uninstall utility will start and remove ZoomBrowser EX.
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Memory Card Folder Structure
Images on the memory card are in either the [DCIM] folder’s [xxx___mm] folder, or the
[xxx_mmdd] folder (xxx: numbers 100 to 999, mm: shooting month, dd: shooting day).

DCIM

xxx___mm
or
xxx_mmdd

IMG_xxxx.JPG (JPEG images)
_MG_xxxx.JPG (JPEG images recorded in the Adobe RGB color space)
IMG_xxxx.CR2 (RAW images)
_MG_xxxx.CR2 (RAW images recorded in the Adobe RGB color space)
STx_xxxx.JPG (Stitch Assist mode images)
MVI_xxxx.MOV*1 (Movies)
MVI_xxxx.AVI, MVI_xxxx.THM*2 (Movies)
MDG_xxxx.MOV (Movies recorded with Movie Digest mode)
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The folder that holds the settings files
for images in the DCIM folder.

CANONMSC

The folder created when DPOF settings are set.
It holds the DPOF settings files.
MISC

• *1 Some camera models create thumbnail image files for index display (MVI_xxxx.
THM). If you delete these files, you will be unable to transfer movies to the camera
from a computer.
*2 Thumbnail image files for index display.
• The “xxxx” in file names represent four-digit numbers.
• Each successive file shot in Stitch Assist mode is assigned a letter starting from “A,”
which is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.JPG],
[STC_0003.JPG]...
• All folders except the “xxx__mm” or “xxx_mmdd“ folders contain image settings
files. Do not open or delete them.
• Depending on the camera, some data types cannot be recorded.
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Troubleshooting
Please read this section if you encounter a problem using the software.

Start by Checking This
Investigate the following points first if you encounter a problem.

Does your computer satisfy the requirements listed in the System
Requirements section?
See “System Requirements” in the Camera User Guide.
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Is the camera correctly connected to the computer?

See the Camera User Guide for the correct connection procedures. Also check to
ensure that you are using the correct cable and that it is securely attached at both
ends.

Are the camera and computer in the correct modes to transfer data?
Some models require the camera to be set to the playback mode to transfer data. See
the Camera User Guide for details.

Is the battery sufficiently charged?

Check the battery charge if you are powering the camera with a battery. You are
recommended to use an AC adapter (sold separately) to power the camera when it is
connected to a computer.
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Problems
Try the suggested solutions to the common problems listed below.

You can’t find transferred images.

Refer to “Changing the Transfer Destination Folder” to confirm where the destination
folder is.

Add New Hardware Wizard displays when the camera is connected to the
computer with an interface cable.
Click [Cancel] to close the window. Temporarily disconnect the camera from the
computer. Next, read Start by Checking This on the previous page and resolve the
problem.
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Camera not detected, Events dialog/AutoPlay/Device Stage won’t display
or images will not transfer to the computer (when camera is connected to
the computer via an interface cable).
The camera may have been recognized as another device.

Solution:

Delete the device with the following procedures.

IMPORTANT
• Computer administrator status is required to perform the following operation.

1

Display the [Device Manager] dialog.
Windows 7:
Click the [Start] menu, [Control Panel], [System and Security], [System], and [Device
Manager].
Windows Vista:
Click the [Start] menu, [Control Panel], [System and Maintenance], [System], and [Device
Manager].
Windows XP:
Click the [Start] menu, [Control Panel], [Performance and Maintenance], [System],
[Hardware] tab, and the [Device Manager] button.

Table of Contents

58

Things to
Remember

2

Mastering
the Basics

More Advanced
Techniques

Appendices

Click the [+] symbol beside the [Other devices], [Portable Devices] and/or
[Imaging devices] category.
Your camera model name or [Canon Camera] will display in these categories if it is being
recognized as an “other” device.
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There are other potential reasons for the problem if the [Other devices], [Portable
Devices] or [Imaging devices] categories do not appear or your camera model name
or [Canon Camera] does not appear. Proceed to Step 5, and temporarily quit the
procedures.

3

Select your camera model name or [Canon Camera], right-click and select
[Delete].

4

Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it appears in one
or more places in the [Other devices] or [Imaging devices] categories.

5

Close [Device Manager] or [System Properties].
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Software Guide

Windows

Disclaimer
• Reprinting, transmitting, or storing in a retrieval system any part of this guide without the
permission of Canon is prohibited.
• Canon reserves the right to change the contents of this guide at any time without prior
notice.
• Illustrations and screenshots in this guide may differ slightly from the actual products.
• The above items notwithstanding, Canon accepts no liability for damages due to mistaken
operation of the products.
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